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Estimated Time:

1.5 hours
LESSON 6
Exploring Microsoft
Office 2007
® OBJECTIVES ® VOCABULARY
Upon completion of this lesson, you should be able to: application window
m  Start Microsoft Office 2007 applications. Dialog Box Launcher
m  Switch between application windows. document window
®  Navigate and identify the common elements in application file
windows. file compatibility
® |dentify the elements in the new Office 2007 user interface. file extension
®  Customize the Quick Access Toolbar. folders
®  Close documents and applications. |-beam
®  QOpen, save, and print documents. insertion point
m  Use onscreen and online Help features. open a document
path
Ribbon
® DATA FILES save a document
To complete this lesson, you will need these data files: ScreenTip
Lesson 6A (a folder containing First Draft Report.docx and scroll

Lesson 6 Worksheet.x|sx)
Step6-7a.docx
Step6-7b.xlsx
Project6-1.docx
Project6-3.pptx
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I MODULE 2 Key Applications

Microsoft Office 2007 is an integrated software package that enables you to share
information between several applications. The applications available in Office 2007
are Word, PowerPoint, Excel, Access, Outlook, OneNote, Publisher, and Accounting
Express. The applications available on your computer depend on which Office 2007
suite is installed and the selections made during the installation. Microsoft offers
several different Office 2007 suites, such as Office Professional 2007 and Office
Home and Student 2007. Each suite offers a different combination of applications.

Each application performs specific tasks. Table 6-1 provides a brief description
of the applications covered in depth in this module: Word, Excel, PowerPoint, and
Access. You will find an introduction to Outlook in the Living Online module of this
text.

TABLE 6-1 Microsoft Office 2007 applications

APPLICATION DESCRIPTION

Access A database application that enables you to organize, manipulate, and
analyze information such as addresses and inventory data

Excel A spreadsheet application that enables you to work with text, numbers,
and formulas to create tables, worksheets, and financial documents

Outlook An e-mail and scheduling application that enables you to manage
e-mail, appointments, tasks, contacts, and events efficiently

PowerPoint A presentation application that enables you to create multimedia slide
shows, transparencies, outlines, and organizational charts

Word A word-processing application that enables you to create and share
documents such as letters, memos, and reports

Starting Office 2007 Applications

2111 Depending on your computer setup and operating system, you can start Office 2007

2.1.2.3 applications by double-clicking the application icon on the desktop, clicking the
application button on the taskbar, or by using the Start button in the bottom-left
@ EXTRA FOR EXPERTS corner of the screen.

You can have multiple applications open at the same time. Each open applica-
To create a desktop shortcut, tion appears on the taskbar at the bottom of the screen. To switch from one open
right-click the application name on application to another, click the application button on the taskbar or click the Switch
the Start menu, click Send To, and between windows button on the Quick Launch toolbar to the right of the Start

then click Desktop (create shortcut). button.

Step-by-Step 6.1

1. Click the Start button 9 on the taskbar. The Word application name
may appear in the most frequently used programs list, as shown in
Figure 6-1.
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LESSON 6  Exploring Microsoft Office 2007 ]

FIGURE 6-1
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Computer
Network
Connect To
| Control Panel

Default Programs

»  AllPrograms Help and Support

Start button fstart Search
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Click All Programs. A complete list of your programs will appear.

When the submenu appears, click the Microsoft Office folder. You may
need to move down through the list to see the folder name.

When the next submenu appears, click Microsoft Office Word 2007.

Click the Start button, click All Programs, click Microsoft Office, and @ EXTRA FOR EXPERTS
then click Microsoft Office Excel 2007. Excel is now the active applica-

If the application icon appears

tion, although Word is still open and running. on the desktop, click the Show
6. Click the Start button, click All Programs, click Microsoft Office, and desktop button [E on thelQUi_Ck
then click Microsoft Office PowerPoint 2007. Launch toolbar, or right-click in a
blank area on the taskbar and click
7. Microsoft PowerPoint is now the active application, although Word and Show the Desktop. Then to start

the application, you can double-

Excel are both still open and running. The taskbar, with three open ) i
click the application icon on the

applications, is shown in Figure 6-2. desktop.

Show Quick Launch toolbar

deskto - - = i

buttonp ‘s Documentl - Micro.., [y Microsoft Excel - Bo.. I (& Microsoft PowerPoi... FIGURE 6-2

The taskbar with multiple

Switch between open application buttons

windows button Applications that are open

8. Click the Excel spreadsheet document button on the taskbar to switch
to that application.
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I MODULE 2 Key Applications

@ EXTRA FOR EXPERTS

9. Click the Switch between windows button on the Quick Launch
toolbar. Icons for all of the open documents will show on your desktop,

If the Windows color scheme on
your computer is set for Windows

and when you move the mouse pointer over the icon, the document title
will show.

Aero, a thumbnail of the applica-
tion window will appear when 10. Select the icon for the Word document to switch to that application.

you position the mouse pointer
over the document button on the

11. Leave the Word, Excel, and PowerPoint applications open.

taskbar. In addition, when you
click the Switch between windows
button on the Quick Launch tool-
bar, Windows Flip 3D will open.
Instead of showing as icons, all of
the open documents will appear
in 3D on the desktop, and you can
use the mouse wheel or press Tab
to cycle through the documents.

D VOCABULARY

application window

document window

114

Navigating Application Windows

2112 When an application is launched, an application window similar to the one shown

2-1.1.3 in Figure 6-3 appears. The application window serves as the primary interface
between the user and the application. The application window includes many of the
elements of all Windows screens, including the title bar, scroll bars, and the status
bar. Most Office 2007 applications will automatically open a new blank document
when the application is launched. The document window is the area where you enter
new text and data or change existing text and data.

Restore Down button

[ H9-0)° Documentl - Micrasaft Word - 2 *_ (Close button
- Home | “Insert | Fageloyout  References  Mailings  Review  View @
Title bar | [0} Cover Page = D Elgl ,_E'P E i i B, typeriink = [ s 2] Quick Parts - [ Signaturs Line =TT Equation - Minimize
(] Blank Page ol Bl — A Bookmark = - A wordar - (5} Date aTime §2 symbol - b
= Table | Picture Clip Shapes Smartirt Chart Header Footer  Fage Text - utton
= Page Break - Art - 4] Cross-reference - +  Numberr || Boxv o= Dropcap - hed Object ~
Document | Fages Tables Tiustrations Links Header & Footer Text Symbols
window &

Insertion
point

[
Status bar I = - = i

Page:1of1 | Wiordsio |

FIGURE 6-3 The Microsoft Word 2007 application window
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LESSON 6  Exploring Microsoft Office 2007 ]

The Microsoft Word window can be resized and moved just like other windows
on your screen by using the Minimize, Maximize, and Restore Down buttons. The

Minimize and Restore Down buttons are shown in Figure 6-3. D VOCABULARY
The insertion point is a blinking vertical line that indicates the location in the insertion point
document where the new text and data will be entered. The arrow keys on the key-  [.peam

board move the insertion point up, down, left, and right in the document. The Page
Up and Page Down keys move the insertion point in bigger increments. To use the
mouse to reposition the insertion point, simply move the mouse pointer to the desired
location within the document. When positioned within the document window, the - HEADS UP
pointer changes from an arrow to an I-beam, which looks like a capital letter I.

scroll

Position the I-beam over the text in the document where you would like the insertion The arrow keys and Page Up and
point, and then click. Page Down keys will not move the

When you scroll through a document, you move through the document on the insertion point in a blank docu-
screen without changing the location of the insertion point. To scroll, use the hori- ment. As soon as text and data are
zontal or vertical scroll bars. Another convenient way to scroll, if available, is to use added to the document, the keys
the wheel on the mouse. The display on the screen adjusts as you scroll. Figure 6—4 will perform as described.

identifies the scroll bar tools.

Scroll up arrow

Vertical
scroll bar
Drag scroll
box |aftor Drag scroll
right box up or
down
Horizontal Scron down
scroll bar arrow
Scroll left ¥ Scroll right
arrow ° arrow

FIGURE 6-4 Using the mouse to scroll

Step-by-Step 6.2

1. If necessary, click the Word document button in the taskbar to show the
blank Word document.

2. Enter your first and last names. Notice that the insertion point moves as
you enter text.

3. Press Enter about 10 times. Notice that the insertion point moves each
time you press Enter.

4. Use the arrow keys and the Page Up and Page Down keys to navigate in
the document window. Each time you press Page Up or Page Down, the
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I MODULE 2 Key Applications

2-1.1.2
2-1.1.3
2-1.1.4

D VOCABULARY
Ribbon

@ EXTRA FOR EXPERTS

For users who are familiar with
earlier versions of Microsoft
Office, the Ribbon has replaced
the menu bar.

116

10.

11.

12.

insertion point will move up or down in the document about the depth
of your screen.

Drag the scroll box and click the arrows on the vertical scroll bar to move
through the document window without moving the insertion point.
Position the mouse pointer between your first and last names and then
click. The insertion point will appear now in the new position. Enter
your middle name or middle initial.

If necessary, click the Maximize button B to change the size of the
window to fill the screen. If the Maximize button does not show in the
top-right corner of the screen, the document is already maximized.

To adjust the size of the window, click the Restore Down button = . The
window will appear smaller, and you can drag the borders to adjust its
size, and you can reposition the window by dragging the title bar. When
the window is restored down, the Maximize button will appear in place
of the Restore Down button.

Click the Minimize button = to reduce the document to a button on
the taskbar. You should see the Excel document. Notice that the Word
document still appears in the taskbar.

Click the Word document button in the taskbar to make it active again,
and if necessary, click the Maximize button to change the size of the
window to fill the screen.

To return to the previous customized window size, click the Restore
Down button. Then, click the Maximize button once more.

Leave the application open.

Using the New Office User Interface

Several of the Office 2007 applications use a new visual design which is referred to
as the Microsoft Office Fluent user interface. There are many new features in this
new design which make the software more intuitive and easier to use.

Using the Office Ribbon

The Ribbon is the blue banner that stretches across the top of the screen, just below
the title bar. As shown in Figure 6-5, the Ribbon shows several tabs, beginning
with the Home tab at the left. The Ribbon makes it easy to find commands because
related commands and options are organized in groups on each tab. For example,
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LESSON 6  Exploring Microsoft Office 2007 ]

all of the commands for formatting characters appear in the Font group. A Dialog ) yoCABULARY
Box Launcher (a small arrow) appears in the lower-right corner of some groups, and Dialog Box Launcher
when clicked, a dialog box will open with even more options.

ScreenTip

Home | Insert  Pagelawout  Refersnces  Mallings  Review  View @
Paste : —~
| calibri (Body) MR S e

button A= (2] i
Pt 4 |B 2 U - e x % A | W - AL | E =SS S 2| rvoma |1Nospaci. Headingl  Headingz - gga‘gsgf

s=l(a]) e @3 Find ~
£=|[24097) | sspnceoc | acsuceo | AaBbEC. AaBbee - M .

4 Replace

[ Select~
Clipboard = Font 2} Paragraph & Styles @] Editing

Dialog Box Launcher for the Font group

FIGURE 6-5 The Home tab on the Ribbon

What makes the Ribbon so unique is that it changes to meet your needs. As
you work in a document, the Ribbon adapts by providing appropriate commands
and options. For example, if you insert a picture in your document, the Ribbon will
change to show options for formatting the picture—hence, the word “fluent” in
Office Fluent user interface.

If you do not know the function of a button in any of the groups, position the
mouse pointer over the button, but do not click. After a second or two, the name of
the command and a description of the command shows in a small window called a
ScreenTip.

If you prefer to use the keyboard instead of the mouse, you can access the
tabs on the Ribbon by using keyboard shortcuts that you can show on the Ribbon.
Commands can also be accessed with legacy keyboard shortcuts, which have been
around for many versions of the application. When a keyboard shortcut is available
for the command, the shortcut is included in the ScreenTip.

Step-by-Step 6.3

1. |If necessary, click the Word button in the taskbar to show the Word
document.

2. On the Home tab, in the Clipboard group, position the mouse pointer
over the Paste button, shown in Figure 6-5. Wait a second or two for
the ScreenTip to appear. The ScreenTip provides the button name, a
keyboard shortcut, and a description of its function.

3. Click the Insert tab on the Ribbon. The groups and options will change.
Position the mouse pointer over several of the commands on the Insert
tab to show the ScreenTips.

5. Click each of the remaining tabs to view the groups and commands. You
will see that the groups and commands are very different on each tab.

6. Press the Alt key. Letters for keyboard shortcuts will appear under each
tab name on the Ribbon. Notice that the letter P appears under the
Page Layout tab name.
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I MODULE 2 Key Applications

7. Press P to show the Page Layout tab. More shortcut keys appear. Press M
to show the margin options. When a command or option is executed, the
shortcut keys will disappear. To hide the keyboard shortcuts without
executing a command, press the Alt key once again, or click a different
tab name.

8. Click anywhere in the white area of the document window to close the
margin options without making any changes. Even though you didn’t
execute a command or option, the shortcut keys will disappear.

9. Click the Home tab to make it active.

10. Click the Dialog Box Launcher ™ in the Font group. The Font dialog box
shown in Figure 6-6 will open.

FIGURE 6-6 Gy & = Close button
The Font d|a|0g bOX Fonk Character Spacing
Fank: Fant style: Size:

Regular 11

CE=TEE - | (s -

Tkalic E m

Font color: Underline style: Underline calor:

Automatic |Z| (none) IZ| Automatic
Effects
[T strikethrough [ shadaw [ Small caps
[T Dauble strikethraugh [T outline [ all caps
[ superscript ] Emboss [ Hidden
[ subscript ] Enarave
Preview
+Body

This is the body theme Font, The current document theme defines which Font will be used,

o) o

11. Click the Close button to close the dialog box.

12. Leave the applications open.

Minimizing the Ribbon

If you want to maximize the screen space for your document window, you can mini-
mize the Ribbon.
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LESSON 6  Exploring Microsoft Office 2007 ]

Step-by-Step 6.4

1. |If necessary, click the Word button in the taskbar to show the Word
document.

2. |If necessary, click the Home tab to make it active. Double-click the

Home tab. The groups and command buttons will be hidden, and only
the tab names will appear, as shown in Figure 6-7.

FIGURE 6-7

\/l:‘D I 29:c:45) = Dacumen e Wieroemreavon _ =
— The Ribbon minimized

Insert  Pagelayout  References  Mailings  Review  View

@X

—ls

=

Click the Insert tab. All the groups on that tab will show.

P

Click anywhere within the document window. The Ribbon will automati-
cally minimize again. The Ribbon will also minimize again if you choose
a command or option.

5. Double-click any one of the tabs to maximize the Ribbon and restore its
original appearance.

6. Leave the applications open.

Using and Customizing the Quick Access Toolbar

By default, the Quick Access Toolbar is positioned above the Ribbon in the upper-
left corner of the application window. This toolbar offers quick access to commands @ EXTRA FOR EXPERTS
you use frequently. The default settings, as shown in Figure 6-8, include only three
options, the Save, Undo, and Redo or Repeat commands; but you can customize the
toolbar to include the commands you use most often. Keep in mind that the intent
of the toolbar is for quick access. If you add too many commands and the toolbar
becomes cluttered, it may slow you down.

You can move the Quick Access
Toolbar so that it appears below
the Ribbon. Click the Customize
Quick Access Toolbar button and
then click the option Show Below
the Ribbon.

= ¥ - & | 5. Customize Quick Access Toolbar button

FIGURE 6-8 The Quick Access Toolbar

Step-by-Step 6.5

1. |If necessary, click the Word button in the taskbar to show the Word
document.

2. Click the Customize Quick Access Toolbar button ™. The current com-
mands on the toolbar are identified with a check mark.
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I MODULE 2 Key Applications

3. Click More Commands to open the Word Options dialog box. The
Customize option is already selected.

4. Double-click a command that is not currently on the Quick Access
Toolbar. Be sure to remember which command you clicked. Click OK.
The width of the toolbar will expand and a new button for the command
will show on the toolbar.

5. Click the Customize Quick Access Toolbar button, and then click the
same command that you clicked in Step 4. This will remove the com-

mand from the toolbar.

6. Leave the applications open.

Closing Documents and Applications

2111 You use the same procedures to close documents and applications in all Office

2.1.25 applications. To close a document, you can click the Close button in the application
window, or you can click the Office Button and choose the Close command. The
- HEADS UP Office Button, positioned at the upper-left corner of application window, is available
in many Office 2007 applications to access basic commands such as Open, Save,

Press Ctrl+F4 as an alternative to Print, and Close.
using the Close button to close the If you have multiple documents open in the application, clicking the Close but-
active document window. Press ton or using the Close command will close only the active document. To close an
Alt+F4 to close the application application and all documents at the same time, you can click the Office Button and
window. click the Exit command. If you attempt to close a document without saving changes,

you will be prompted to save the changes before closing.

Step-by-Step 6.6

1. If necessary, click the Word button in the taskbar to show the Word

document.

2. Click the Office Button ™ to show the commands and options shown in
Figure 6-9.
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@gﬂ LR

Recent Documents
| News

1 Recycling ‘Vehicles.doo: {=1
— e 2 Projectll-1.doc: {=1
o 3 Recycling Symbol.doce =
4 Stepll-Fa.doc {=1
H Sawe
lﬂ Save &5k
5 Print 4
:5% Frepare b
_a Send ]
Click to close || 34/ Publish »
thedocument || _ Click to exit
o Cose the application

|._} word Options | |X Exit Ward |

3. Click Close. You will be prompted to save the changes to the document.
Click No. The document window will close, but the application will still
be active.

4. Click the Office Button, and then click Exit Word. The application win-
dow will close. You should see the Excel application window, but if not,
click the button on the taskbar to switch to the Excel document.

5. Click the Office Button, and then click Exit Excel. If prompted to save
the changes, click No. The document window and the application
window will both close. The PowerPoint application and document are
still open.

6. Click the Close button in the upper-right corner of the application
window. If prompted to save changes to the document, click No. No
application or document buttons should appear in the taskbar, and you
should see the desktop.

Opening, Saving, and Printing Documents

You use similar procedures to open and save documents in all Office applications.
To open a document means to load a file into an application. A file is a collection of
information saved as a unit. Each file is identified by a filename. Remember that the
terms document and file are used interchangeably.

FIGURE 6-9
The Close and Exit commands

r

1=

\
2-1.1.4
2-1.1.7
2-1.2.2
2-1.2.3
2-1.24
2-1.2.6

D VOCABULARY
open a document

file
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I MODULE 2 Key Applications

TECHNOLOGY TIMELINE
Why QWERTY?

The arrangement of a standard keyboard on a computer (or a typewriter) is called QWERTY, referring to the
first six characters in the top row of letters. But why aren’t the letters in arranged in alphabetical order,

or some other logical order? Why QWERTY? The most popular story is that the inventor of the typewriter,
Christopher Sholes, created the layout of the keyboard in the 1860s to keep commonly used key combina-
tions separated. This was so that the typebars, which moved the metal letters to the ribbon when you struck
the keys, would not crash into each other. Although no evidence exists to prove that this is why the arrange-
ment of keys was chosen, the QWERTY keyboard really does make it more cumbersome to type frequently
used letters. And even though electric typewriters, and then computers, eliminated all possibility of keys
crashing together, we still use this old keyboard.

In the 1930s, a university professor named August Dvorak designed a keyboard that would allow faster
typing with less finger movement. He placed the most commonly used letters on the “home” keys in the
middle row of letter keys, and a typist can enter many English words without ever leaving the home keys.
It's been estimated that a typist’s fingers might travel 16 miles in a day using a QWERTY keyboard but only
1 mile using the Dvorak keyboard. Yet we're still using the QWERTY model. Why? Well, the answer seems to
be that people are just set in their ways, and they don’t want to learn a new system. Also, U.S. government
tests in the 1950s actually found that there just isn't a big difference in typing speed between the two
keyboards to make it worth changing the standard layout. Good typists type faster than bad typists, no
matter what keyboard they use.

Opening a Document

The Open command, which is accessed using the Office Button in most Office 2007
@ EXTRA FOR EXPERTS applications, enables you to open a file from any available disk and folder. You can
also open a document by navigating to the document on the desktop or by using the
file management system on the computer. Once you locate the file, double-click the
filename. If necessary, your computer will launch the associated application (such as
Word or Excel), and then the document will open.

A file extension typically identifies the type of file. A period separates the file-
name and the extension. The extension is usually three or four characters and varies
depending on the application used to create the document. For example, Word 2007
automatically assigns the extension docx, PowerPoint 2007 assigns the extension
pptx, and Excel 2007 assigns the extension xlsx. The “x” in the extension indicates
the XML format. You can quickly identify documents created in earlier versions of
these applications because the file extensions are doc, ppt, and xIs.

Folders are containers used to organize the documents into manageable groups
on a designated storage device. All computer files are saved in folders, and folders
can also be created within folders. The path is the route the operating system uses to
locate a document. The path identifies the disk and any folders relative to the loca-
tion of the document. Figure 6-10 shows two typical paths and identifies the items
in the paths. The first example shows a document named Volunteer.docx saved in
D VOCABULARY a folder called Assignments. The Assignments folder is, in turn, stored in a folder
called CLB Key Applications, which can be found on the local (this computer’s)
hard drive—drive C. In the second example, the Word document named Volunteer.
docx is saved in a folder called Assignments, which can be found on a Flash/USB
path removable memory drive, which in this example is identified as Removable Disk

(E2).

To preview a file before opening

it, click the Start button and then
click Documents in the list at the
right. When the dialog box opens,
click Organize and then click
Layout. If necessary, click Preview
Pane to enable the option. The
icon at the left of the option will
be surrounded by a blue box when
enabled. Navigate to the file and
click the filename to show the doc-
ument in the Preview pane. Click
anywhere in the Preview pane, and
then you can scroll through the
document.

file extension

folders
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Local Disk (C):\CLB Key Applications\Assignments\Volunteer.docx

Disk Folder Folder Filename

Removable Disk (E):\Assignments\Volunteer.docx

Disk Folder Filename

FIGURE 6-10 Typical paths to file locations

Just as you can open multiple applications, you can also open multiple docu-
ments within each application. Each open document appears on the taskbar. When
several documents are open for one application, the taskbar shows only the name of
the application on the taskbar. Click the application button on the taskbar to open a
list of all open documents for that application. To make a document active, click the
filename from the list.

Step-by-Step 6.7

1. Start the Word application.
@ HEADS UP

of documents that have been accessed recently in this application, as You can control the number of file-
names that appear in the Recent

Documents list by changing the
you can click the document filename and it will open. display settings for the application.
The maximum number of docu-
ments you can display is 50.

2. Click the Office Button. To the right of the commands, you will see a list

shown in Figure 6-9. If the document you want to open is in that list,

3. Click Open. An Open dialog box appears. Word automatically takes you to
the drive and folder of the last folder you opened, so your dialog box will be
similar to the one shown in Figure 6-11, but it may not be identical.

Current path  [zjeem FIGURE 6-11
@7@-[ | » Computer » LacalDisk (C) » DataFilesforStudents » KeyApplications » Lessanil b ~ [ 42 ][ searcn Bl The open d|a|0g box
Back and
L e T —
| LessanllA
buttons B T ] Projectl1-1.dacx
H] Recent Places W] Step11-Ta.docx
M Deskiop
8 Computer
[E| Documents
B Pictures
Click to g N
X & Recently Change
display the || g sesrches
Folders list || & posic
Folders ~

4. Navigate to the location where the data files are stored. (Your instructor
can provide this information.) To locate the DataFilesforStudents folder,
select the folder from the Favorite Links list or use the Folders list.
Clicking the Back button will return you to the previous drive or folder.
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@ HEADS UP

To open multiple documents at the
same time, click the first filename
in the Open dialog box, hold down
the Ctrl key, and click one or

more additional filenames, then
click Open.

D VOCABULARY
file compatibility
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10.

11.

12.

13.

14.

After you click the Back button, the Forward button will appear and
then you can navigate through the folders in both directions.
Double-click the DataFilesforStudents folder, then double-click the
KeyApplications folder, and then double-click the Lesson6 folder.
There is one folder, Lesson 6A, and two Word files, Step6-7a.docx and
Project6—1.docx, in the Lesson6 folder.

Click the All Word Documents (*.docx;...) list arrow at the lower-right
corner of the dialog box, and then click All Files (*.*). The names of all
files in the Lesson6 folder are listed, including those created in applica-
tions other than Word.

Click the filename Step6-7a.docx once to select it, and then click
Open, or double-click the filename.

Start Excel.
Click the Office Button, and then click Open.

Navigate to the DataFilesforStudents folder again and open the
KeyApplications folder. Double-click the Lesson6 folder to open it. Then
double-click the Lesson 6A folder to show the Excel file in that folder.
Notice that the current path for the location of the document shows at
the top of the Open dialog box.

Click the Back button at the upper-left corner of the dialog box to return
to the list of folders and files in the Lesson6 folder. Click the Back
button again to return to the list of folders and files in the KeyApplications
folder.

Click the Forward button twice to return to the list of folders and files in
the Lesson6 folder. Double-click the filename Step6-7b.xIsx to open it.

Click the Office Button. Notice that the document you just opened in
Excel, Step6—-7b.xlsx, appears at the top of the Recent Documents list.
Click the Office Button again to close the list of commands, and leave
the applications open.

Solving Problems with Opening Files

You may encounter some problems when opening files. The following are descrip-
tions of common problems.

There is a problem with file compatibility. File compatibility refers to the ability
to open and work with files without a format conflict. In most cases, files that
were created with an older version of application software can be opened in
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the newer version of the software. But sometimes, files created in newer appli-
cations are not backwards compatible, meaning that they cannot be opened in
older versions of the software. Office 2007 files are saved in a new format, and
they will not normally open in earlier versions of Office applications. Microsoft
does, however, provide a free download of compatibility software to enable
users with older versions of Office to open, edit, and save files created and saved
in the new Office 2007 format.

B You may also encounter compatibility problems if you are working in a different
operating system than the one in which the file was created. For example, if a
file was created in PowerPoint on a Macintosh, it may not open in PowerPoint
on a PC. This problem generally occurs if you are working with different ver-
sions of the software across the different platforms. With a little effort, however,
you can usually find a way to open and use almost any Office file.

B When you use the Open command from the Office Button, you do not see the
file for which you are looking. This could be caused by a number of things. First,
you need to verify that the document was saved before it was closed. Second,
you need to verify that you are looking in the right drive and the right folder, as
the file for which you are looking may be stored in a different location. If the file
is stored in a remote storage area or on a network, you must make sure you have
access to the storage area or the network. If you are unsure of the location of the
file, you can use the Search command, available in the upper-right corner of the
Open dialog box, to locate the file. To use the Search feature, you must identify
the drive and/or folders in the box to the left of the Search box. Or, you can click
the Start button and enter the filename in the Search box.

B The file is in a format that cannot be read by the application you are using. For
example, if you attempt to open an Access file using the Open command in the
Word application, you will not see the file listed. You can switch the file type
within the Open dialog box to show All Files, but that does not necessarily mean
that the application you are using will be able to open the file. In general, it is
better to open a file in its associated application and then export to the appropri-
ate file format for the application in which you want to open the file.

B You encounter a corrupted file or a file that will not open. The application may
give you an error message when you try to open the file, it may cause the appli-
cation to shut down, or it may just not open. In these cases you can try to open
the file on a different computer to verify that the file is indeed corrupt and that
there isn’t something wrong with your computer.

Saving a Document

To save a document means to store it on a disk or other storage medium. You can
save a document to the hard drive on your computer, to the computer desktop, to an
auxiliary drive or a network location, or to portable media such as Flash/USB remov-
able memory, or a writable CD/DVD disk. A file extension is automatically added to
the filename when the document is saved.

To make it easier to find documents, choose filenames with words that help
describe the document. The complete path to the file can include up to 255 charac-
ters. Filenames cannot include any of the following characters: \, /, :, *, 2, ©, <, >, .

You should make a habit of saving frequently and after making any major
changes to your document. The quickest and easiest way to save a document is to
click the Save button on the Quick Access Toolbar. When you click the Save button
on the toolbar, the document is saved with the same filename and in the same loca-
tion. If the file does not already have a name, the Save As dialog box will open and
you can enter a name for the file. Unless you specity a different location, the file will
be saved to the default location.

R
@ HEADS UP

The new file format for Word
2007, PowerPoint 2007, and
Excel 2007 is based on an XML
(Extensible Markup Language)
format, which affects how files are
stored. The benefits of the XML
format include a smaller file size
and improved recovery of damaged
or corrupted files.

D VOCABULARY

save a document

@ EXTRA FOR EXPERTS

You can show file extensions in
Windows Vista by changing an
option in your system settings.
Open the Start menu, click Control
Panel, click Appearance and
Personalization, and then choose
Folder Options. Click the View tab.
Under Advanced settings, you will
see the option Hide extensions

for known file types. The option is
turned off when the check mark is
removed.

125


enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight

enas.altarawneh
Highlight


I MODULE 2 Key Applications

When you change the filename or the location in which the file is stored, the
original document, with the original name, remains unchanged. When you use the
Save As command, you also have the opportunity to change the document format.
Each application offers a number of choices for formats in which to save files.

Step-by-Step 6.8

FIGURE 6-12
The Save As dialog box

@ EXTRA FOR EXPERTS

You can create a new folder by
clicking the New Folder button
. The new folder will
be added to the folder that is cur-
rently open in the dialog box.
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1.

Current path

g

Click the Word button on the taskbar to switch to the Step 6-7a.docx
document.

Click the Office Button and then click Save As. The Save As dialog box
shown in Figure 6-12 will open. The current path appears at the top of
the dialog box.

9] Save As (=3
1 |u| . % Local Disk {C:) » Assignments - |‘f | | Search P |
By Organize ~ E2E Views ~ [ Mew Folder )

e Name Date madified Type Size
B e This folder is empty.
= Recent Places
Bl Desktop
% Computer
E, Documents
E Pictures
More »
Folders -~
File name: Recycling Symbol -
Save as type: ’Word Document (*.docx) -
Authors: Your Name Tags: Add atag
[ Save Thumbnail
4 Hide Folders Tools v [ Gave | [ Cancel |

If you have an Assignments folder, use the Favorite Links list or the
Folders list to locate it. You can specify the folder, directory, network
drive, or other remote drive in the Folders list. If you do not have an
Assignments folder, follow your instructor’'s directions about where to
save the document.

In the File name box, the filename Step6—7a.docx is already selected.
(If the text in the File name box is not highlighted, click in the box and
select or delete that text.) Then enter Recycling Symbol.

Click the Save button in the dialog box. The document is saved in a new
location and with a different filename.
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6.

10.

Click the Excel button on the taskbar to switch to the Step6-7b
document.

Click the Office Button and click Save As. Save the file in your
Assignments folder (or as directed by your instructor). Change the file-
name to Expense Report.

In the Save as type box, the default setting for the Excel file format is
Excel Workbook (*.xslx). Click the Save as type list arrow and change
the file type to Text (Tab delimited) (*.txt). You may need to scroll down
in the list to find this option.

Click Save. If you see a message box warning you that the selected
file format does not support multiple worksheets, click OK and Yes to
continue.

Leave the applications open.

Printing a Document

Some of the commands in the Office Button include submenus, which provide more
options without first opening a dialog box. When you point to the arrow next to the
Print command, three print options appear in a submenu, as shown in Figure 6-13.

@ d9-o -

j Mew Preview and print the document
{ Print
“u | Select a printer, number of copies, and
7 Open other printing options before printing.
(@ Quick Print

save " Send the document directly to the default
i printer without making changes.

= [ Print Preview
lﬂ SaveAs b

Preview and malke changes to pages before
printing.

- Prepare »

Sengd 3

m

;:Ef Publish »

J LClase

|p_:’j Ward Options | |X Exit Word

FIGURE 6-13 The Print submenu
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—l— WARNING

Check with your instructor about
the policy for printing documents
in this course.

Step-by-Step 6.9

FIGURE 6-14
The Print dialog box

128
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The Print option opens the Print dialog box, and you can select a printer, the
number of copies to print, and the range of pages to print. You can also change
the printer settings (such as print quality or the color settings using the Properties
button). The options within the Print dialog box will vary, but most of the print
options are similar for all applications. If your computer accesses more than one
printer, you will want to choose the Print command so you can select the printer
you want to use.

The Quick Print option sends the content in the active window or document
directly to the printer, and you will not have the opportunity to change the print-
ing options or printer settings. The default printer options will be applied.

The Print Preview option enables you to see exactly how the document will
look when it is printed. The printed copy produced by the printer may not look
exactly the same as what you see on your screen, so it is good practice to use the
Print Preview option.

Click the Word button on the taskbar to switch to the Recycling Symbol.docx
document.

Click the Office Button and click Print. A Print dialog box similar to the
one shown in Figure 6-14 will open.

Print 7=
Prinker
Marne: W_‘ﬂ Microsoft ¥PS Document Writer |Z|
Status:  Idle Find Prinker . ..
Type: Microsoft ¥PS Docurment Wiker
Where:  ®PSPort: [T print to file
Comment: [T Manual dupley
Page range Copies
@ all Mumnber of copies: |1 $
~) Current page Selection H 1
o S 1‘ 1‘ Collate
Type page numbers and/or page

ranges separated by cormmas counting
from the start of the document or the
seckion. For exarple, type 1, 3, 5-12
or plsl, pls2, pls3—p8s3

Print what: | Document IZ| Zoom
Print: all pages in range IZ| Pages per sheet: 1 page IZ|
Scale bo paper size: | Mo Scaling IZ|
options.. . [ (o4 ] ’ Cancel ]

In the Printer section, click the list arrow in the Name box. If your
computer is connected to more than one printer, the other printers will
appear in this list. Click on the title bar of the dialog box to close the list
without making any changes.

In the Page range section, click to select Current page. When this option
is selected, only the page where you last positioned the insertion point
will print.
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5. Click the option for Pages. When this option is selected, you can enter a
specific page number in the text box (for example, 2). Use hyphens for
a page range (for example, 1-3), and use commas to separate pages or
page ranges (for example, 1, 3-5).

6. Click Cancel to close the dialog box without printing. (To print, you
would click OK, but there is no reason to print this document.)

7. Click the Office Button, position the mouse pointer over the Print com-
mand, and then click Print Preview in the submenu. The document will
appear in the Print Preview window, and the Ribbon will adapt to pro-
vide commands and options for printing, changing the page layout, and
viewing the document.

8. On the far right of the Print Preview tab, click the Close Print Preview
button.

9. Close the Word and Excel applications. If you are prompted to save
changes to the documents, click No.

Getting Help

The Office 2007 applications have some very powerful Help features to assist you
as you work. You have access to documentation including books and manuals and
online help as well. Do not overlook another vital source of help: assistance from
others. There may be classmates, instructors, or coworkers who are familiar with the
application you are using. Or perhaps your workplace has a help desk. You can com-
municate with support personnel via phone, e-mail, user groups, and blogs.

The key to using these various sources of help is determining what sort of help
you need and the quickest or most efficient way to access that help. The idea is to
find the assistance you need without interrupting or delaying your work. Whenever
you encounter a problem, your first source of help should be the Help features in
each Office application. Help is always readily available and is just a few mouse
clicks away. For example, you can find out more about most dialog box options by
clicking the Help button, which looks like a question mark, on the title bar of the
dialog box. This button opens a Help window that provides information about the
options available in that dialog box.

Navigating the Help screens is much like navigating a Web page. You can browse
the categories presented and click on links to get information about a topic. You can
also enter keywords (specific words or phrases) in the Search box. The results for
your search will be listed, with links for the most relevant results at the top of the list.
Your success in getting useful search results depends on your ability to identify the
keywords that relate to your query. The more you search, the better you get at rec-
ognizing keywords for your searches. To access previous searches, click the Search
list arrow.

If your computer is connected to the Internet, you will also have access to all the
current Help information available at the Microsoft Web site or other support spe-
cialists. At the Microsoft Office Online Web site you will find a variety of resources,
including tours, slide shows, tutorials, training videos, articles, product user groups,
blogs, and the opportunity to chat with Microsoft support personnel. If the word
Oftline appears at the bottom of the Help dialog box, your computer is not currently

\
2-1.1.8
2-1.1.9

@ HEADS UP

The keyboard shortcut to access
the Help feature is F1.

@ HEADS UP

To reposition the Help dialog box,
drag the title bar. You can also
resize the dialog box by dragging
one of the borders.
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FIGURE 6-15

The Word Help dialog box
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connected to the Internet, but you can still access Help information from files stored
on your computer. You may need to check with your instructor about how to connect
to the Internet from your computer.

Enter keywords
for search

Links for several
Word Help topics

Start Microsoft Office Word 2007.

Click the Help button @ on the upper-right corner of the application
window. The Word Help dialog box shown in Figure 6-15 will open. The

Step-by-Step 6.10

dialog box includes a search box and several links for browsing Word

Help topics.
€ Word Help - - x
€ (3 0 @ & & A @@ g
+ O Search -
-
3
s
wihat's new Activating Wword
Getting help Creating specific documents
Converting documents Wiewing and navigating )
Margins and page setup Headers and footers
Page numbers Page breaks and section breaks
Writing Formatking
Tracking changes and comments Lists R
Tables ‘Working with graphics and charts
Tables of contents and other Mail merge
references
Saving and printing Collabaration
File management Custamizing
Accessibilicy Security and privacy
Autarnation and pragranmmability Add-ins L
Al word | 9 Comnectedto office Online

Show Table of
Contents button

Click to access
previous searches

Click to connect to
Office Online Web site

Click the Show Table of Contents button 7 in the dialog box to show the
Table of Contents, which will appear on the left side of the dialog box.

Click Getting help in the Table of Contents. More links related to the
topic will appear. Click Getting help again to hide the links.

Position the insertion point in the Search box. Enter the keywords

display recent documents.

Click Search. Topics that may provide an answer are listed in the

dialog box.
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10.

11.
12.

Click the link Customize the list of recently used files. If your computer

is connected to the Internet, you may need to scroll down to see the

option in the list. A new Help screen will open.

Scroll down and click the link Word to choose the program you are using.

Read and follow the three steps. You can keep the Word Help dialog box

open as you complete the task. If the dialog box is in the way, reposition

it or resize it.

After you complete the third step, instead of clicking OK, click Cancel

in the Word Options dialog box.
Close the Word Help dialog box.
Close Word.

SUMMARY

In this lesson, you learned:

You can start Office applications by clicking the Start but-
ton on the taskbar and selecting the application from the All
Programs menu, or you can double-click the application icon
on the desktop.

Common elements found in Office application windows
include the title bar, scroll bars, and status bar.

You can maximize the space for the document window by min-
imizing the Ribbon.

You can customize the Quick Access Toolbar by adding or
removing command buttons.

To close document windows and application windows, you
click the Close button in the application window or click the
Office Button and then click the Close command or Exit.

B VOCABULARY REVIEW

The Open dialog box enables you to open a file from any avail-
able disk and folder.

Problems opening files can involve corrupted data or file
compatibility issues, such as trying to open a file in a differ-
ent application, in an earlier version of an application, or in an
operating system other than that used to create it.

To save a document using a new filename, you click the Office
Button and then click the Save As command.

To print a document, you click the Office Button, point to Print,
and then choose a print option.

ScreenTips provide immediate help without interrupting your
work. The Help window and the Office Online Web site are
also sources of assistance.

Define the following terms:

application window
Dialog Box Launcher
document window

file

file compatibility

file extension
folders

I-beam

insertion point
open a document

path

Ribbon

save a document
ScreenTip

scroll
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B REVIEW QUESTIONS

TRUE / FALSE

Circle T if the statement is true or F if the statement is false.

T
T
T
T

T

F 1. The Ribbon is one of the new features in the Microsoft Office Fluent user interface.

A disk is a collection of information saved as a unit.

F 2
F 3. Using the scroll bar to navigate through a document also repositions the insertion point.
F 4

The insertion point is a blinking vertical line that indicates the location in the document where the new text and data will be

entered.

F 5. Even though Office 2007 files are saved in a new format, they are backwards compatible, meaning they will normally open in

earlier versions of Office applications.

MULTIPLE CHOICE

Select the best response for the following statements.

1.

. To save a file with a new filename or to a new location,

. To view more options in a group on the Ribbon,

The Office application you would use to organize and manipulate information such as addresses and inventory data is

A. Outlook C. Access
B. Word D. Excel

A. click the Save button on the Quick Access Toolbar

B. click the Save As New button on the Quick Access Toolbar
C. click the Office Button and then click New

D. click the Office Button and then click Save As

. The serves as the primary interface between the user and the application.
A. document window C. Switch between windows button
B. application window D. Start button

A. maximize the Ribbon C. double-click a Ribbon tab

B. click the Dialog Box Launcher D. customize the Quick Access Toolbar

. The is the route the operating system uses to locate a document.
A. file extension C. path
B. folder D. navigation trail

FILL IN THE BLANK

Complete the following sentences by writing the correct word or words in the blanks provided.

1.

are used to organize the documents within a disk.

2. When positioned within the document window, the mouse pointer changes from an arrow to a(n)

capital letter 1.

3. A(n) is usually three or four characters in length and defines the type of file.
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4. refers to the ability to open and work with files without a format conflict.

5. A(n)
control in the application window.

B PROJECTS

is a small window with descriptive text that appears when you position the mouse pointer over a command or

PROJECT 6-1

1. Start the Word 2007 application.

2. Start the PowerPoint 2007 application.
3. Switch to the Word application.
4

. Navigate to the data files and open the file
Project6-1.docx. The path for the data file is
DataFilesforStudents\KeyApplications\Lesson6.

5. Save the document in your Assignments folder with the new
filename Recycling Vehicles.

6. Click the Page Layout tab on the Ribbon.

7. In the Page Setup group, show the ScreenTip for the
Margins button.

8. Minimize the Ribbon, and then restore it.

9. Use the keyboard to move the insertion point to the end of the
document, and enter your first and last name.

10. Click the Office Button and click Save to save the changes to
the document.

11. Scroll back to the top of the document.

12. Leave the document and applications open.

PROJECT 6-3

1. Switch to the PowerPoint application.

2. Open Project6-3.pptx from the data files. The path for the
data file is DataFilesforStudents\KeyApplications\Lesson6.
The PowerPoint window shows a slide, an outline of the cur-
rent presentation, and an area where you can add notes.

3. Save the PowerPoint presentation in your Assignments folder
using the new filename Three Rs.

4. Click the View tab. Notice that there are seven buttons in the
Presentation Views group.

5. To learn more about the different views you can use in
PowerPoint, open the PowerPoint Help dialog box, enter
change views in the Search box, and click Search. In the list
of results for the search, click When and how to use views in
PowerPoint 2007.

6. Read about the Normal view and the Slide Sorter view, and
then close the PowerPoint Help dialog box.

7. Close the PowerPoint application.

8. Close the Word application.

PROJECT 6-2

1. If necessary, open the file Recycling Vehicles from your solu-
tion files.

2. Add the Open command button to the Quick Access Toolbar.

3. Remove the Open command button from the Quick Access
Toolbar.

4. View the document in Print Preview, and then close the Print
Preview window.

5. Close the Recycling Vehicles document. If prompted to save
any changes, click No, and leave the applications open.

TEAMWORK PROJECT

Your supervisor has decided to assign some projects to teams of
employees, and he has asked you and a coworker to investigate what
tools Office 2007 offers for collaborative work. Working as a team,
use the Office Help features, the Internet, and other resources such
as people you know who use Office applications to find out how
Office application features enable more than one person to work
on a document in Word, PowerPoint, and Excel. Make a list of the
reviewing, tracking, and other applicable features in each of the
three applications and indicate how you access the features from
the applications.
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B CRITICAL THINKING

I MODULE 2 Key Applications

ACTIVITY 6-1

In exchange for riding privileges, you have agreed to help the owner
of alocal riding stable with a number of computer-related tasks. The
owner has created the following list of jobs she needs to have done:

A. Write letters to people who board their horses at the stable to
tell them feed bills will go up at the beginning of the year.

B. Store information on owners, frequent riders, equipment, and
employees.

C. Schedule regular visits by the vet, keep track of regular chores,
and plan activities in coming months.

B ONLINE DISCOVERY

D. Calculate expenses for running the stable as well as income
from riders and boarders.

E. Prepare a presentation that can be used to train new employees
and new riders.

Which Office applications would you use to complete each of these
jobs? Make a table that lists each job and the Office application you
would use to complete the task. Are there other jobs you could do
for the stable owner using Office applications?

At the beginning of this lesson, Table 6-1 provides a brief overview
of the Microsoft Office applications covered in this textbook: Word,
Excel, PowerPoint, Access, and Outlook. Microsoft offers several
more Office applications. Browse www.microsoft.com to learn about
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other Office applications that are available. Create a list of these
other Office applications, and include a brief description about the
purpose of each of application.





